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 98 

Of the many metabolites that are are involved in any clinical condition, only a narrow 99 

range of biomarkers is currently being used in the clinical setting. A key to personalised 100 

medicine would be to extend this range. Metabolic fingerprinting provides a more 101 

comprehensive insight, but many methods used for metabolomics analysis are too 102 

complex and time-consuming to be diagnostically useful. Here, a rapid evaporative 103 

ionization mass spectrometry (REIMS) system for direct ex vivo real-time analysis of 104 

biofluids with minor sample pre-treatment is detailed. The REIMS can be linked to various 105 

laser wavelength systems (such as OPO or CO2 laser) and with automation for high-106 
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throughput analysis. Laser-induced sample evaporation occurs within seconds through 107 

radiative heating with the plume guided to the MS instrument. The presented procedure 108 

includes (i) laser set-up with automation, (ii) analysis of biofluids 109 

(blood/urine/stool/saliva/sputum/breast milk), and (iii) data analysis. We provide the 110 

optimal settings for biofluid analysis and quality control, enabling sensitive, precise and 111 

robust analysis. Using the automated set-up, 96 samples can be analysed in ca. 35-40 112 

minutes per ionization mode, with no intervention required. Metabolic fingerprints 113 

enclose about 2000 to 4000 features, for which relative quantification can be achieved at 114 

high repeatability when total ion current normalization is applied. With saliva and feces as 115 

example matrices, more than 70% of features had a coefficient of variance ≤ 30%. 116 

However, to achieve acceptable long-term reproducibility, additional normalizations by 117 

e.g. LOESS are recommended, especially for positive ionization.  118 

 119 

Introduction 120 

To date, metabolic fingerprinting of human biological fluids is most typically accomplished 121 

through high-resolution mass spectrometry (HRMS) in hyphenation with a chromatographic 122 

separation technique such as capillary electrophoresis, liquid or gas chromatography1,2. This 123 

analytical approach allows for the sensitive and selective measurement of low-molecular 124 

metabolites (< 1500 Da), generating a metabolic read-out that can be used to gain 125 

interesting insights in biological and (patho)physiological processes3,4. More specifically, 126 

biomarker metabolites and biological pathways can be shown to be associated with 127 

particular phenotypes of human health and disease5. This approach does, however, have 128 

some substantial shortcomings that strongly restrict the general application potential; i.e. 129 

protocols are often laborious and involving elaborate sample preparations, which contribute 130 
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to relatively low sample throughput rates and high costs as well as a significant risk for 131 

artefacts such as metabolite degradation, causing variable or poor recovery2. These 132 

requirements and limitations mean that metabolic fingerprinting by hyphenated HRMS is 133 

not practical for e.g. point-of-care testing in clinical practice. Indeed, in that setting, there is 134 

a high need for simplicity and automation to analyze large sample batches, there is only 135 

limited time for sample analysis, the measurements are of an individualized nature, and the 136 

physical sample size available is often limited6,7.  137 

It is therefore productive to explore alternative analytical strategies such as ambient 138 

ionization mass spectrometry that are able to produce metabolic fingerprints, but that don’t 139 

require extensive sample preparation or chromatographic separation. With ambient 140 

ionization techniques, samples are analysed in their native environment or after minimal 141 

pre-treatment; and gas-phase ions are generated under open-air conditions and directly 142 

introduced into the mass spectrometer6,8. Traditionally, ambient ionization has been 143 

achieved through various desorption ionization methods such as ambient pressure matrix-144 

assisted laser desorption (AP-MALDI), direct analysis in real-time mass spectrometry (DART-145 

MS), desorption electrospray ionization (DESI), and secondary ionization mass spectrometry 146 

(SIMS). These approaches have been used successfully in the analysis of intact (ex vivo) 147 

biological tissues, but are not suitable for ionising living tissues. There, thermal evaporation 148 

techniques have become the norm, including thermal electrosurgery and laser surgery9,10.  149 

These have mostly been used to determine the position of the borders between malignant 150 

tumours and healthy tissue11.  151 

Only recently, laser assisted ambient ionization mass spectrometry (LA-REIMS, laser assisted 152 

rapid evaporative ionization MS) has also been exploited (by the authors of this paper) for 153 

rapid, real-time fingerprinting of various human biofluids, i.e. saliva, urine, feces, sputum, 154 
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breast milk and plasma7,12,13. In this approach, the process of laser ablation is based on the 155 

laser-emitted infrared wavelength regime that excites the most intense vibrational band 156 

(oxygen-hydrogen stretching mode) of the water molecules that are highly present in the 157 

respective biological fluids, initiating matrix-assisted desorption and ionization of intact 158 

biomolecules14. It should be noted that, in comparison with other techniques, laser assisted 159 

ionization does not require the usage of solvents (versus e.g. DESI), high voltages or gas 160 

flows (e.g. DART, 2 to 4 kV discharge needle voltage and 1.5 to 3.0 L/min gas flow rate), nor 161 

does it require direct contact with the sample (e.g. hand-held sampling devices such as the 162 

iKnife that are typically used to cut through tissue and rapidly heat it, to generate a vapor)7. 163 

The approach that is used in this protocol is very similar to the iKnife, but the fact that there 164 

is no probe that has direct contact with the samples means that the cleaning requirements 165 

and the risk of sample-to-sample contamination are substantially lower. These are 166 

considered essential conditions for platform automation.  167 

In LA-REIMS , no pre-treatment is needed for the analysis of fresh feces, urine, plasma, 168 

breast milk and sputum, and only centrifugation and filtration are required for saliva 169 

analysis. As such, fingerprinting of biofluids by LA-REIMS could generally be achieved within 170 

less than 1 min per sample7,12,13. In addition, we assume that artefactual metabolite 171 

modifications are less likely to occur in experiments with fewer sample processing steps and 172 

shorter analytical times. In comparison with hyphenated techniques, LA-REIMS has 173 

substantially fewer analytical biases relating to sample pre-treatment, extraction and 174 

storage (i.e. samples are analysed in or very close to their native condition), or resulting from 175 

chromatographic and mass spectrometric drifts (i.e. the analysis times are much shorter).  176 

Without chromatographic separation, however, metabolome coverage is likely to be lower 177 

as characterization of metabolite-associated features is based on mass measurements only. 178 
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As such, it will for example not be possible to separate isomers and isobars. This also limits 179 

the possibilities for quantification. Data from LA-REIMS are thus not as comprehensive as 180 

those from conventional metabolic fingerprinting approaches (i.e., UHPLC-HRMS)4. In 181 

addition, secondary ionization of ablated metabolites at the rapid evaporative ionization 182 

(REI) collision surface may also suffer from ion suppression, which has adverse effects on 183 

sentivity and quantification accuracy15. As such, biofluid metabolomics by LA-REIMS may 184 

primarily find acceptance in first-line segregation of samples based on distinctive fingerprints 185 

and according to (patho)physiological state, as has been demonstrated by a number of 186 

clinical studies7,12,13. For a more detailed read-out of the metabolome, conventional 187 

hyphenated techniques can be used to achieve advanced separation and in-depth 188 

characterization as well as quantification of metabolites. 189 

Laser ablation ambient ionization mass spectrometry has also been described for rapid 190 

metabolic fingerprinting of tissue (e.g. by Fatou et al., 2016)14 and is the subject of another 191 

Nature Protocol (i.e., Ogrinc et al., 2019)8. This manuscript, therefore, focuses on rapid 192 

metabolic fingerprinting of biofluids and captures the experience gained in multiple studies 193 

published by the involved authors. Key procedural differences are found at many stages of 194 

the protocol: at the level of the instrumental set-up (e.g. the need for a T-shaped connector 195 

piece at the REI-source to concentrate the low metabolite concentrations as present in the 196 

aerosol), instrumental settings (both with respect to the laser as well as the REI-mass 197 

spectrometer) as well as biofluid sample handlings (e.g. specific volumes, pre-treatments, 198 

and cleaning procedures). This work also describes how to adapt the method for 199 

automation. 200 

 201 

Ex vivo direct biofluid molecular fingerprinting using LA-REIMS 202 
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The LA-REIMS methodology (Fig. 1) comprises direct ablation following laser irradiation and 203 

subsequent aerosolization from the sample surface under analysis. In this protocol, an 204 

Nd:YAG laser (operating wavelength of 2.94 μm) and CO2 laser (operating wavelength of 205 

10.64 μm) for laser irradiation are described. A detailed comparison between these laser 206 

types can be found in the study of Schäfer et al. (2011)16 that reported on the reproducibility 207 

of analysis, induction of photochemical processes, coagulative properties, and uniformity of 208 

the generated mass spectra according to wavelength, specifically assessed for tissue. For 209 

biofluid analysis, own research indicated the suitability of both laser types to achieve 210 

comprehensive metabolic fingerprinting, however, without having made explicit 211 

comparisons. The energy of the emitted infrared laser beam is absorbed by the water 212 

molecules, abundantly present in the biological matrices, as a result of the stretching 213 

vibrations of the hydroxyl groups17. This desorption and ionization mechanism has the 214 

unique advantage of being able to exploit the presence of  abundant endogenous water18,19. 215 

The setup also features an MS-source (i.e., REI-source) that is specifically designed to 216 

efficiently draw the produced aerosol through an aerosol vent transmission tube 217 

(millisecond timescale) into the deep vacuum region of the MS-instrumentation. This tube 218 

interfaces the MS-source by means of an orthogonally mounted T-shaped connector piece 219 

and designated insert that is surrounding the aerosol inlet tube. In the source, declustering 220 

of the aerosol, comprising desorbed droplets of both positive and negative analyte ions, 221 

takes place by collision onto a heated impactor, whereby individual molecular species are 222 

generated. Therefore, LA-REIMS is a two-step technique involving desorptive release of the 223 

chemical components and secondary ionization mechanisms18. Ionization is assisted by a 224 

solvent matrix, for example isopropylalcohol, that is provided at the REI-source20. This 225 

solvent plays a MALDI-like role in that it reduces intermolecular forces and improves ion 226 
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formation. More specifically, the polar protic nature of isopropylalcohol is useful in 227 

dissolving lipid species and as such, enables the formation of individual molecular ions via a 228 

collision driven ion release mechanism (heated impactor) which ultimately enhances the 229 

signal-to-noise ratio21. Moreover, aerosol dilution reduces fouling at the inlet capillary 230 

resulting in better spectral classifications and allowing the instrument to run under high-231 

throughput conditions. The flow rate of the solvent matrix is optimized for every biological 232 

matrix type (e.g. 150 µL/min for feces) and can contain a ‘lock mass’ external calibration 233 

compound (e.g. 10 ng/mL leucine-enkephalin).  234 

As a measure of securing consistency in the analysis process through reduction of operator-235 

related factors and to further increase the analysis speed, an automated versatile multiwell 236 

plate-based platform was incorporated in the standard REIMS workflow. The latter serves to 237 

introduce fully remote and automated fingerprinting of a large number (up to 576) of small 238 

volumes of biological material in a fraction of time. Additionally, as positioning the samples 239 

inside the restricted area of each well results in a more uniform sample distribution 240 

compared to the open area of the microscope slide, the microplate configuration 241 

contributes further benefits to standardization of analyses. A flowchart (Fig. 2) presenting 242 

the entire procedure from sample collection to data processing is provided. 243 

 244 

Applications of the method  245 

Whereas blood is the most sampled biofluid in clinical research, diverse alternatives are 246 

available that can be accessed non-invasively and offer an at least equally rich and 247 

chemically diverse metabolome coverage, reflective of various biological processes. Among 248 

those are urine (a key harbor of metabolic waste products11 addressed in e.g. illicit drug 249 

screening), saliva (parallels metabolic alterations occurring in blood and applied in studying 250 
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e.g. obesity22), stool (ideally suited to study the diet-microbiome-metabolome axis in gastro-251 

intestinal disorders, e.g. type 2 diabetes23), and sputum (a means to study 252 

bacterial activity within the airways, e.g. in cystic fibrosis24). LA-REIMS provides an almost 253 

instantaneous fingerprinting strategy without (or hardly) damaging the analysed biofluids 254 

and as such allows for cross-evaluation with conventional methodologies. In this regard, the 255 

LA-REIMS platform described presently, has recently demonstrated rapid fingerprinting of 256 

saliva and feces, each complemented by metabolic profiling and cross-evaluation against 257 

established UHPLC-HRMS metabolomics and lipidomics platforms4,25,26 for in-depth 258 

biological interpretation. The ambient ex vivo analysis of both cited biofluids allowed the 259 

establishment of validated multivariate models that were predictive for assigning metabolic 260 

perturbations according to pathophysiology, i.e. weight and glycaemic state, and provided 261 

general classification accuracies of 97.1% and 90.5%, respectively4. Thus, LA-REIMS 262 

represents an expedient strategy in first-line distinctive metabotyping based on easy to 263 

obtain biofluids12.  264 

 265 

Limitations and potential improvements of the protocol  266 

The LA-REIMS method presented here suffers similar limitations as many other methods in 267 

the field of ambient ionization mass spectrometry and wider fields of direct and flow 268 

infusion MS27. These limitations arise from the removal of chromatographic separation of 269 

the chemical contents of a sample, prior to ionization. For LA-REIMS, this means that ion 270 

formation for a sample’s metabolic fingerprint is condensed into a two to eight second time 271 

frame compared to hyphenated methods, such as LC- and GC-MS, where molecules are 272 

introduced for ion generation over a typical 10 to 20 minute period7. Due to ion suppression 273 

effects, this will likely result in a lower sensitivity of the LA-REIMS method compared to 274 
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hyphenated methods, even when the same high resolution mass spectrometer is used for 275 

analysis. The usage of internal or external standards may provide a relevant strategy to 276 

address this issue, although it is not possible to reach sufficient representativeness for all 277 

metabolome constituents. In addition, the lack of chromatographic separation also hampers 278 

the structural identification of features. Indeed, without having retention time as an 279 

orthogonal separator, it is not straightforward to cluster different m/z-features that are 280 

originating from the same metabolite (e.g. [M+H+] and [M-H2O+H+] ionization adducts) nor is 281 

it possible to distinguish metabolites that are represented by identical or similar m/z-values 282 

(i.e., isobars or structural and stereoisomers)28. This can be somewhat overcome through 283 

usage of the instrument’s tandem MS functionality and the consultation of repositories with 284 

fragmentation data. However, interpretation of fragmentation data is not evident as 285 

metabolites with identical or similar m/z-values will be subjected to the the same selection 286 

and fragmentation event, resulting in intertwined fragmentation m/z-spectra. Moreover, the 287 

inclusion of fragmentation scan events during the short period of the burn is at the expense 288 

of the full-scan events, which may have adverse consequence for the sensitivity and 289 

quantification accuracy. Hence, the information that is obtained from chromatographic 290 

separation and that is supportive for identification cannot be easily replaced. One strategy 291 

to improve the analytical resolution of LA-REIMS, being equivalent to chromatographic 292 

separation, could be the application of ion mobility separation29. As separation occurs on the 293 

millisecond scale, it complements the method’s rapid analysis time and provides a second 294 

dimension to analytical resolution. Moreover, it is does not interfer with the full-scan events. 295 

Usage of ion mobility would, however, add extra complexity to instrumental operation and 296 

maintenance, which not fully aligns with the purpose of LA-REIMS to translate metabolomics 297 

into clinical practice and for point-of-care implementations. In this respect, as earlier noted, 298 
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LA-REIMS is merely proposed as a strategy for first-line seggragation of samples, without in-299 

depth biological-mechanistic explorations.  300 

Further benefits to the LA-REIMS method could be achieved through alternative means of 301 

sample heating and evaporation, particularly with regard to the pulsatile and wavelength 302 

characteristics of lasers. It may be possible to target specific chemical classes through 303 

optimisation of laser choice, reducing ionization competition and improving analytical 304 

sensitivity. Similar benefits could be pursued through modification of the solvent matrix 305 

including different polarities, or through the addition of additives to enhance the ionization 306 

of particular analytical targets30. 307 

 308 

Experimental design 309 

Sample preparation  310 

The method allows for the analysis of freshly collected as well as thawed specimens (Box 1). 311 

If samples cannot be analysed immediately upon collection, storage at -80 °C is 312 

recommended to preserve the metabolic fingerprint. Aside from temperature conditions, 313 

maximal storage duration should be considered when designing the experiment as well31,32. 314 

Liquid samples can be aliquoted and frozen without treatment, while semi-solid matrices 315 

(such as feces) should preferentially undergo lyophilisation33 prior to storage.  316 

Quality control samples  317 

In addition to samples under investigation, external quality control (eQC) samples should be 318 

prepared for instrument conditioning and internal quality control (iQC) samples for 319 

monitoring instrumental performance and possible data normalization. For cohort studies, 320 

these QC sample can be prepared by aliquoting and thoroughly mixing equal volumes from a 321 

selection of representative samples (i.e., including the assessed disease states, age 322 
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categories, treatments, etc.) or, preferably, from all biological samples. The final volume of 323 

the QC blend should allow to include ten eQCs per ionization mode at the beginning of the 324 

sequence and two iQCs every 20 to 40 analytical runs (depending on batch size and available 325 

sample volume)12. On the other hand, a reference material that is not directly derived from 326 

the sample batch for analysis can be used as well, being self-assembled from any excess 327 

experimental samples or commercially available (e.g. pooled human serum, MP Biomedicals, 328 

cat.no 2930149). This may be particularly useful for discontinuous LA-REIMS analysis of 329 

samples across several analytical batches, e.g. for general metabotyping or specific diagnosis 330 

of patients.  331 

 332 

BOX 1 ⏐Sample preparation ● Timing 0-15 min 

 

This box describes sample handling and preparation for analysis of freshly collected as well 

as previously frozen samples. 

 

! CAUTION When using human samples in experimental settings, all necessary local and 

global ethical regulations should be fulfilled.  

 

Additional materials 

 

- Plastic microcentrifuge tubes (2 mL, Eppendorf, Germany, cat. no. 0030120094) 

- Microcentrifuge (MicroCL 17, Thermo Fisher Scientific, USA, cat. no. 75002406) 

- Analytical balance (ML104T/00, Mettler Toledo, USA, cat. no. 30243394) 
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- 1 mL Luer slip syringes (Becton Dickinson, USA) 

- Polyamide membrane filters (CHROMAFIL®, 13 mm diameter, 0.45 μm pore size; 

Macherey-Nagel, Germany, cat. no. 91652) 

- Sartorius Arium 661 UV water purification system (Sartorius, Germany, cat. no. 

H2OPRO-UV-B-TOC) 

- Vortex shaker IKA vortex genius 3 (IKA-Werke GmbH & Co. KG, Germany, cat. no. 

0003340000) 

 

Procedure 

▲CRITICAL STEP All frozen samples should be defrosted at 4 °C shortly before described 

pre-treatment procedures. 

 

Saliva 

1. Vortex raw  samples (freshly collected or defrosted) during 30 s at 400 x g and room 

temperature (25 °C) to ensure homogenization. 

2. Transfer 450 µL of each sample into separate microcentrifuge tubes. 

3. Centrifuge at 17 000 x g for 5 min at room temperature. 

4. Collect all resulting supernatant in 1 mL syringe and pass through polyamide membrane 

filter into new microcentrifuge tube. This can be analysed immediately or stored at -80 °C, 

preferably  for less than 1 month34.  

 

Feces 

1.   Freshly collected stool samples can be homogenized manually with a sterile spatula or 
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using commercially available homogenizers (e.g. Stomacher®) according to manufacturer 

guidelines. Following homogenization, these samples are ready for LA-REIMS analysis.  

2.  If prolonged storage of fecal samples is required, consider lyophilising the samples. 

They can then be stored at -80 °C, preferably for less than 2 months31. 

3. When preparing the lyophilised samples for LA-REIMS analysis: 

(i) Weigh 200 (± 1) mg of lyophilized homogenized feces in 1.5 mL microcentrifuge tube. 

(ii) Add 600 μL of ultrapure water. 

(iii) Thoroughly mix by vortexing for 60 s at 400 x g (if homogeneity is not achieved, 

additionally a sterile spatula may be used) and keep at 4 °C prior to analysis. 

Urine and blood plasma 

1. Freshly collected samples do not require any pre-treatment. If analysis is not performed 

immediately, samples can be stored at -80 °C for preferably less than 1 month35,36. 

2. Defrosted samples require a homogenization step, by vortexing at 400 x g for 30 s and 

keep them at 4 °C prior to analysis. 

Human milk 

1. Homogenise freshly collected samples by vortexing at 400 x g for 30 s. These can be 

analysed directly or frozen for storage at -80 °C for preferably less than 3 months37.  

Vortex after defrosting at 400 x g for 30 s and keep at 4 °C prior to analysis. 

2. If the analytical focus is fat and complex lipids, perform refrigerated centrifugation (4 °C) 

for 5 min at 3000 x g to create a fat layer that can be directly analysed by LA-REIMS. If 

required, the fatty layer can be removed from the aqueous phase with a sterile single-use 

10 μL microbiological inoculating loop and transferred to a sterile microcentrifuge tube for 

separate analysis. 
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Sputum 

1. Freshly collected samples do not require any pre-treatment. If analysis is not performed 

immediately, frozen samples can be stored at -80 °C for at least 1 month38. Defrost at 4 °C 

prior to LA-REIMS analysis. 

C. If desired for easier homogenization of the sample matrix, sputum can be treated with 

Sputasol (#SR0233, Oxoid, ThermoFisher Scientific, USA) following standard 

manufacturer’s instructions. This can be completed on freshly collected samples prior to 

analysis or prior to storage at -80 °C. Homogenisation may be necessary where visible 

colour heterogeneity exists within the sample or variations in consistency across the 

sample is noted, and which is not resolved through vortex mixing. During experimental 

design, consideration should be given to whether sample homogenization with Sputasol 

should be undertaken regardless of sample appearance as it would be a likely source of 

bias to only treat a selection of samples.  

Quality control samples 

1. Define how many analytical runs will be considered for the LA-REIMS experiment 

and calculate how many QC runs are needed. Guidelines regarding the number and 

frequency of eQC and iQC samples have been defined previously (section ‘Quality 

control samples’).  

2. For determination of the total volume needed, take into account the 

recommended starting-volumes per matrix type (see section ‘Procedure’ below) 

and consider a separate glass microscope slide / well for every QC run. 

3. Establish a QC-pool by taking equal aliquots from (a selection of) representative 

samples or by considering general reference material. Vortex the QC-pool 
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thoroughly. 

4. Store the QC-pool at -80 °C if LA-REIMS analysis is performed, either continuously 

or discontinuously, for several days. Consider aliquoting of the QC-pool for storage, 

in order to avoid freeze-thaw cycle effects.  

 333 

LA-REIMS system set-up 334 

Laser set-up 335 

MID-IR laser: The installation used comprises a MID infrared laser system (OpoletteTM 336 

HE2940, OPOTEK LLC, USA) consisting of a Q-switched Nd:YAG laser pumping Optical 337 

Parametric Oscillator (OPO). The system output is fixed at 2.94 μm wavelength, 6 mJ peak 338 

OPO energy, 7 ns pulse duration and 20 Hz repetition rate. Q-switch delay time is a tunable 339 

parameter with a direct impact on the transferred laser energy. The delay time may be 340 

optimized for each biofluid matrix separately depending on the produced peak intensity and 341 

repeatability, ranging between 165 and 180 μs (see ‘Equipment set-up’ section). The OPO 342 

beam transmission and focusing on the sampling area is achieved by the free space steering 343 

optics consisting of 3 metallic-coated mirrors and a plano-convex lens placed directly above 344 

the sampling surface. The sampling area position 5.5 cm below the focusing lens as well as 345 

the laser focusing optics represent a fixed construction and, once set and aligned, do not 346 

require routine tuning before each experiment. Laser beam and external optics alignment 347 

verification, however, have to be performed on any new installation and systematically 348 

checked (Box 2). 349 

 350 

CO2 laser: This is typically a modified surgical CO2 laser, operated at a 10.6 µm wavelength. 351 

Previous publications have utilised an OmniGuide FELS-25A (OmniGuide, Massachusetts, 352 
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USA) or Aesculight VetScalpal (Aesculight, Washington, USA) using either mirror optics or a 353 

hollow core fibre for laser beam transmission. A single mirror focusing handpiece is used to 354 

direct the beam to a spot size of ca. 500 µm. These surgical CO2 lasers are used as they have 355 

been created for the cutting and cauterising of animal tissue, and their wavelength and 356 

absorbance profiles are thus complementary to the analysis of biological materials. They are 357 

typically at the lower end of CO2 laser powers (<10 W) which are commercially available, 358 

particularly when compared to industrial CO2 lasers (>100 W) used for cutting/engraving 359 

applications. Optimisation of CO2 laser power and delivery can be carried out for different 360 

biological materials by altering the power output, pulsatile window, and distance between 361 

focusing lens and sample. The output of the CO2 laser should be periodically checked with an 362 

appropriate power monitor (such as Pronto-250-PLUS, Gentec Electro Optics, Quebec, 363 

Canada) to ensure output is within the expected range.  364 

 365 

BOX 2 ⏐MID-IR laser alignment verification procedures ● Timing 20 – 30 min 

 

This box describes laser alignment and routine alignment verification for the MID-IR OPO 

laser. Alignment of the CO2 laser follows a similar principle. 

 

! CAUTION Always wear eye protection with sufficient optical density while operating the 

laser. Consult Class 4 laser safety measures and equipment manual for additional 

precautions while operating the installation.  

 

Additional equipment 
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- MIR Detector Cards: 1.5 to > 13.2 µm (Thorlabs GmbH, Germany) 

- Optical alignment target (shipped with OpoletteTM HE2940 MID-IR laser system) 

 

Procedure 

Laser alignment verification 

▲ CRITICAL Beam alignment has to be performed on a new installation and assessed 

periodically following manufacturer recommendations or whenever laser misalignment is 

suspected (e.g. you have moved the setup). 

1. On the front panel of the Opolette laser head, expose the laser pump port by moving 

the shutter marked ‘1064’ to the side. 

2. Screw the optical alignment target to the port with the uncovered area up (thus 

allowing visualization of the alignment target interior). 

3. Set Q-switch delay time to 320 μs in the Q-switch configuration menu within laser 

control software or on handheld remote controller panel.  

4. Activate the laser beam by consecutively pressing the ‘Start’ buttons on the flash lamp 

and Q-switch sections of the remote control/control software. The green light should 

appear around the alignment target aperture. 

5. Check the position of the green light beam on the alignment target aperture. If the 

beam is centred, the laser is aligned and can be safely operated. Otherwise contact 

OPOTEK support centre. 

6. Press the ‘Stop’ button subsequently on the flash lamp and Q-switch sections of the 

remote control/control software to deactivate the laser. 
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? TROUBLESHOOTING 

! CAUTION Do not decrease Q-switch delay time below 300 μs while aligning as it may 

damage the alignment verification target.  

! CAUTION Do not further operate the system if the laser is misaligned or if the correct 

alignment cannot be verified.  

 

External optics alignment verification 

▲ CRITICAL Correct alignment of the laser steering optics is required for sufficient energy 

transmission and is crucial for operator safety. 

7. To activate the alignment diode, toggle the switch at the back of the laser pump case. 

The red light will become visible as projected on the sampling surface guided by the set of 

metallic-coated mirrors. 

8. Check the projected position of the diode light on the working surface: the beam 

should pass through the middle of the focusing plano-convex lens. If not, adjust the 

positions of the metallic-coated mirrors. 

9. Set the laser system in the operation mode as described in step 2 of the protocol. 

10. Place the thermosensitive MIR detector card underneath the focusing lens so that the 

projected alignment diode light is visible on the card’s surface. 

11. Activate the laser beam by pressing the ‘Start’ button subsequently on the flash lamp 

and Q-switch sections of the remote control/control software. 

12. The area of the discoloration on the MIR detector card will indicate the projection of 

the laser beam and that position should overlap with the alignment diode projection. 

13. Deactivate the laser by consecutively pressing the ‘Stop’ buttons on the Q-switch and 
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flash lamp sections of the remote control/control software. 

14. Toggle the switch at the back of the laser pump case to deactivate the alignment 

diode. 

 366 

LA-REIMS sample analysis 367 

As a measure to ensure accurate laser energy transmission to the sample, it is essential to 368 

establish the correct position of the laser optics and/or sampling area prior to analysis in 369 

such a way that the laser focus point lays within the surface or the top layer of the specimen. 370 

Besides, as the laser focusing lens is positioned merely 5 cm above the sampling surface and 371 

hence prone to contamination resulting from the ablation process, it is important to monitor 372 

and assure its cleanliness during the analytical runs. In particular, the state of the lens should 373 

be evaluated every 5 to 10 ablations4, depending on the sample type. When contaminated, 374 

the lens should be cleaned with a cotton swab drenched in ethanol. Interestingly, 375 

positioning samples in a microtiter plate (automated sampling, see below) instead of on 376 

glass microscope slides (manual sampling, see below) reduces the distribution of liquid 377 

splashes during ablation and the resulting focusing lens contamination, hence the frequency 378 

of cleaning. In case of automated sampling using microtiter plates significant focusing lens 379 

contamination and associated decrease in MS signal intensity (with more than one order) 380 

has been observed only after 30 to 50 ablations (depending on the matrix type under study). 381 

Nevertheless, we recommend lens cleaning to be performed at least every 5 ablations 382 

during manual sampling and every 12 ablations during automated sampling to anticipate any 383 

possible signal issues (Step 30 of the protocol).  384 

For the manual analysis, 20 to 50 μL of the liquid biofluid (or thin layer of fecal blend) is 385 

pipetted on a glass microscope slide. Next, the slide is manually transferred under the laser 386 



  
 

 22

beam focusing point and irradiated for 3 s and removed. In between sample ablation, the 387 

solvent signal is recorded for 3 to 4 s to ensure that the signal intensity drops to the 388 

background level and guarantee good peak resolution (Fig. 3). The method acquisition time 389 

is set to 30 s per sample which is sufficient to generate 2 to 3 technical replicates (ablations) 390 

within one acquisition period, if desired12.  391 

The automated sampling platform employs a simple in-house made two-axis (XY) motorised 392 

precision position stage (Fig. 4a) that can hold up to 6 different 96-well plates on the mobile 393 

platform. The customized controlling software defines the platform movements and laser 394 

activation/deactivation sequence. The moving stage subsequently positions the samples in 395 

the separate wells under the laser focusing point. Every irradiation (ablation) is followed by a 396 

cooldown period during which the next well is positioned below the laser focusing point and 397 

a new acquisition datafile is initiated by the recording software. The sample volume within 398 

each well is recommended to be at least 50 and up to 100 μL as bigger volumes are better 399 

preserved during prolonged exposure of the liquid samples to ambient conditions during 400 

automated analysis as opposed to manual sampling. Although the recommended sample 401 

volume is substantially higher when using automated sampling compared to manual 402 

sampling, the (semi-)liquid within the well plates can be subjected to repeated laser 403 

ablations without loss of signal intensity or spectrum quality (Table 3). An additional 404 

measure that can be taken to minimize passive evaporation of the specimens within the 405 

wells during analysis, is the installation of a local thermoelectric (Peltier) cooling element in 406 

the sampling area to create an optimal (cooled) microenvironment.   407 

Daily calibrations of the MS instrument during active sample analysis periods should be 408 

performed according to manufacturer guidelines to ensure the highest mass accuracy (e.g. 409 

sodium formate solution in 90:10 isopropylalcohol:water (v/v) for calibration of Waters 410 
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QToF/Q-IMS-ToF instruments)7,12. Moreover, when starting the instrument after cleaning or 411 

planning sample analysis for different matrices, it is advised to run 10 to 20 pooled eQC 412 

samples in both ion modes to secure adequate instrument conditioning before starting the 413 

analysis or switching to another matrix type12. This measure reduces initial signal drift within 414 

the samples of interest during the actual experiment. A representative number of iQC 415 

samples (two between every 20 to 40 analytical run) should be analysed to monitor and 416 

compensate for possible MS signal output changes during the analytical run (analytical drift). 417 

A final strategy to ensure the quality of collected data is the usage of external standards 418 

infused together with the solvent matrix (e.g. leucine-enkephalin7 or a combination of 419 

palmitic acid-d31 and 1,2-dimyristoy-d54-sn-glycero-3-phosphocholine12). This allows for 420 

evaluation of instrument analytical performance as well as lock mass correction and data 421 

normalization.  422 

 423 

LA-REIMS data collection 424 

Data collection is performed using MS vendor-specific software. All MS methods for 425 

automated programs are set at 18 s per sample acquisition time, while 30 s is used upon 426 

manual sampling4. Mass spectra can be collected as one raw data file per sample, which may 427 

reduce downstream data processing but increase time for data collection. Alternatively, one 428 

raw data file per microwell plate or batch could be generated, which may then decrease 429 

time for data collection as a result of reduced instrument electronic control but requires the 430 

splitting of files and thus increases subsequent downstream data processing. 431 

 432 

Data analysis & classification modelling 433 
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Data analysis can be performed using any kind of software that runs the appropriate sort of 434 

algorithms. Box 3 describes the procedures that were followed, using the software that was 435 

available to the authors of this protocol. 436 

During LA-REIMS analysis, molecular fingerprints are acquired by MS vendor-specific 437 

software, such as MassLynxTM (v4.2, Waters, stored as .raw directories) in case of Waters 438 

instruments. Prior to performing classification modelling, several pre-processing steps are 439 

implemented to select representative burns, subtract background and noise, and perform 440 

peak picking (Box 3, Steps 1-12). In general, these pre-processing steps are also executed 441 

using vendor-specific software (Progenesis®  Bridge, Progenesis®  QI, AMX or Live ID, 442 

Waters). Alternatively, spectra can be pre-processed using freely available open-source 443 

metabolomics software such as XCMS39, MZmine40, etc.  444 

Following pre-processing, peak lists of m/z-features are subjected to multivariate statistical 445 

analysis, typically including principal component analysis (PCA41) and orthogonal partial least 446 

squares discriminant analysis (OPLS-DA42) (using software packages such as SIMCA (v15, 447 

Sartorius)) (Box 3, Steps 13-22). PCA serves as an unsupervised dimension reduction 448 

technique to investigate variance within the dataset. OPLS-DA is a supervised regression 449 

methodology whereby user-defined groups are taken into account, thereby pursuing 450 

classification of the groups based on discriminative features. The (validated) models can be 451 

utilized to extract discriminative features that can further undergo identification using 452 

fragmentation experiments and database matching. 453 

In Box 3, data analysis and classification modelling from raw files collected on the LA-REIMS 454 

instrument (Waters), is described by the sequential use of Progenesis® Bridge (v1.0.29, 455 

Waters), Progenesis® QI (v2.1, Waters) and SIMCA (v15, Sartorius) software. 456 
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BOX 3 ⏐ LA-REIMS data analysis & classification modelling ● Timing 1 h for ca. 500 

samples 

 

This box describes the pre-processing and classification modelling (steps 31-34 of the 

Procedure) that is performed after data acquisition by LA-REIMS. This biostatistical 

pipeline can be used for any type of analyte described in this protocol, and uses three 

commercially available software packages.  

The first program, Progenesis® Bridge (v1.0.29, Waters), is capable of handling Waters MS 

.raw directories and performs background subtraction, lock mass correction (optional), 

creates extracted ion chromatograms for each burn and separates multiple burns in each 

raw folder into individual raw folders. This separation enables individual burns to be 

treated as individual samples. For further treatment in Progenesis® QI, all individual peak 

raw folders can be loaded or 1 peak per sample can be selected. In case of the latter, it is 

suggested to use the peak with the highest total ion current (TIC) value. TIC can be 

assessed by manually inspecting each chromatogram in MassLynxTM (Waters).  

Next, the raw data are ready for importing into the second software program, 

Progenesis® QI (v2.1, Waters), where peak picking and TIC normalization is performed 

and lists of m/z-features are generated. In a third software program, SIMCA (v15, 

Sartorius), fingerprints can be visualised, quantified and statistically classified, and 

discriminating features can be defined. The data analysis pipeline consists of the steps 

summed below. 

Procedure 
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1. Open Progenesis® Bridge, fill in fields a. to d., as described below, and click ‘Run’. 

a. Source: directory path containing non-processed Waters .raw directories. 

b. Output path: directory path where processed data will be stored. 

c. TIC replicate threshold: threshold between background and peak intensity. 

Should be set at approximately 1/3 of peak height.  

? TROUBLESHOOTING 

d. Lock Mass Correction: None. 

2. Open Progenesis® QI, click ‘File’ > ‘New’ and fill in experiment name and directory 

path. 

3. Set the analysis parameters of new experiment a. to c., as described below, and click 

‘Next’. 

a. Type of machine: direct sample analysis. 

b. Data format: profile data. 

c. Ionization polarity: select correct polarity according to the experiment.   

4. Select the possible adducts according to the experiment and click ‘Create 

experiment’. 

5. In the created experiment window, in tab ‘Import Data’, choose Waters (.raw) 

format and click ‘Import’ to select and import files that need to be processed. 

6. In the created experiment window, in tab ‘Import Data’, click ‘Start automatic 

processing’. 

a. Experimental design can be left empty at this stage, click ‘Next’. 

b. Set the peak picking parameters by clicking ‘Set parameters’, fill in and click 

‘OK’. 
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i. Peak picking limits > Sensitivity: Automatic – default. 

ii. For the other parameters, default values should be attained. 

7. In the created experiment window, in tab ‘Experimental Design Setup’, click 

‘Between-subject Design’, fill in and click ‘Create design’. 

a. Design: new design. 

b. Group runs manually.  

c. Create design. 

8. In the created experiment window, in tab ‘Experimental Design Setup’, select all 

samples, click ‘Add Selected Runs to Condition’. 

9. In the created experiment window, in tab ‘Peak Picking’, click ‘Review 

Normalisation’, click ‘Normalisation Method’ and select ‘Normalize using total ion 

abundance’. 

10. In the created experiment window, in tab ‘Review Compounds’, check information 

of compounds. 

11. Click ‘File’ > ‘Export compounds measurements’, select information to export and 

click ‘OK’. 

a. Select Compound, m/z, normalized abundance, raw abundance. 

12. Transpose, rearrange and add classification labels prior to loading peak lists into 

SIMCA. Optionally, (internal) quality control normalization can be performed during 

this step. 

13. Open SIMCA, click ‘File’ > ‘New’ > ‘Regular Project’. 

14. Paste the data from the .csv file into the ‘SIMCA Import’ window. 

15. Create workset by defining the data, click ‘Finish import’. 
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a. Define the row head as ‘Primary ID’. 

b. Define the column head as ‘Primary ID’. 

c. Define the 2nd column head to select a data type ‘Y variable with Qualitative 

Data’ or ‘Y with Quantitative Data’; depending on the experiment type. 

? TROUBLESHOOTING 

16. In the ‘Home’ tab, click ‘Change model type’ > ‘PCA-X model’. 

17. In the ‘Home’ tab, Click ‘Edit’ to control the PCA settings, click ‘OK’. 

a. Click tab ‘Scale’, select all and choose type: e.g. Par (Pareto scaling). 

b. Click tab ‘Transform’, select all, choose ‘Specify transformation’: Log, click ‘Set’, 

select box ‘If one variable in the X or Y block needs transformation, transform 

all selected variables in that block’ and click ‘Transform’. 

18. In the ‘Home’ tab, Click ‘Autofit’ and ‘Scores’ to visualize model. 

19. In the ‘Home’ tab, Click ‘New as’ > ‘PCA-X’ (copy settings previous model), click 

‘OK’.  

20. In the ‘Home’ tab, click ‘Change model type’ > ‘OPLS-DA model’. 

21. In the ‘Home’ tab, Click ‘Edit’ to control the PCA settings, click ‘OK’. 

a. Click tab ‘Observations’ to check classes are selected; if not: select samples per 

class, name the new class and click ‘Set’. 

b. Click tab ‘Observations’ to exclude samples (e.g. QCs): select sample and click 

‘Exclude’. 

22. In the ‘Home’ tab, Click ‘Autofit’ and ‘Scores’ to visualize model. 

 457 

Materials 458 
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 459 

Biological materials  460 

• Stool samples: For development of the LA-REIMS procedures as well as to perform rapid 461 

fingerprinting in a context of clinical diagnostics, stool samples were collected from study 462 

participants that provided written, informed consent, following approval of the study by 463 

the ethics committee. For the examples described in this protocol, samples were 464 

collected under University Hospital Ghent Ethical Committee (EC 2016/0673). Collection 465 

of stool material is preferable performed by using specifically designed equipment, such 466 

as e.g. the Fecotainer® or FecesCatcher (De Fecesvanger, The Netherlands; both of these 467 

products provide detailed instructions. Other tools (e.g. plastic bag, plastic disposable, 468 

bucket, etc.) are also suitable although considered less convenient for the study 469 

participant. Upon collection, fresh stool samples should immediately be frozen at -80 °C 470 

if possible, i.e. if sample collection takes place at e.g. the hospital, research facility, etc. If 471 

the sample is collected at the participant’s home, temporary storage at -20 °C will be 472 

needed, but should be kept as short as possible. Transport of the sample to the relevant 473 

facilities should be realized under cooled conditions (0 °C or lower; using ice packs, dry 474 

ice, or liquid nitrogen). Prior to storage at -80 °C, lyophilization is advised in order to 475 

remove water and stop microbial activity. In this study, lyophilization was achieved by 476 

placing the samples in a Christ 1-4 Alpha LSCplus lyophilisator for 48 ± 4 h at -40 °C. 477 

Lyophilized samples were grinded with pestle and mortar and sieved (mesh size of 2.5 478 

mm) to obtain a homogenous powder.  479 

To demonstrate the application potential of LA-REIMS stool fingerprinting in a clinical 480 

context, stool material was collected from male and female study participants with 481 

normal blood glucose levels and those that were diagnosed with type 2 diabetes, 482 
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thereby applying a classification threshold of 60 mmol/mol glycated haemoglobin (Hb 483 

A1c).  484 

<CRITICAL> It is important that stool material is not contaminated with urine during its 485 

collection. <CRITICAL> Fresh (non-lyophilized) samples should be kept frozen at all times 486 

to avoid metabolic alterations. 487 

• Blood samples (plasma): For development of the LA-REIMS procedures as well as to 488 

perform rapid fingerprinting in a context of clinical diagnostics, blood samples were 489 

collected from study participants that provided written, informed consent, following 490 

approval of the study by the ethics committee. For the examples, described in this 491 

protocol, samples were collected under University Hospital Ghent Ethical Committee (EC 492 

2016/0673).  493 

Blood samples were collected from the study participants using a 10-mL syringe and 494 

transferred into a heparin-containing tube, which was centrifuged for 10 min at 2800 to 495 

3000 x g (at 2 – 8 °C). The obtained plasma was transferred to a cryovial and stored at -496 

80 °C. If needed, transport of the plasma samples should be realized under cooled 497 

conditions (0 °C or lower; using ice packs, dry ice, or liquid nitrogen). <CRITICAL> 498 

Samples should be kept frozen at all times to avoid metabolic alterations. Thawing of the 499 

material for LA-REIMS analysis should be performed at 4-6 °C. <CRITICAL> Upon long-500 

term storage (> 1 year), protein precipitation may occur, for which additional purification 501 

measures should be taken prior to LA-REIMS analysis.  502 

• Saliva samples: For development of the LA-REIMS procedures as well as to perform rapid 503 

fingerprinting in a context of clinical diagnostics, saliva samples were collected from 504 

study participants that provided written, informed consent (or parents in case of 505 

minors), following approval of the study by the ethics committee. For the examples, 506 
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described in this protocol, samples were collected under University Hospital Ghent 507 

Ethical Committee (EC 2016/0673). 508 

Collection of saliva should be established under standardized protocols to minimize the 509 

impact of confounding factors; e.g. with respect to brushing of the teeth, the time slot of 510 

sample collection, dietary restrictions with respect to food and drinks consumption prior 511 

to sample collection, etc. Collection of saliva can be achieved by passive drooling or 512 

usage of suitable swabs such as e.g. Salivette® synthetic (Sarstedt, Germany) or SalivaBio 513 

(SalivaBio, Germany) swabs. After collecting the saliva material in a cryovial, snap-514 

freezing and/or storage at -80 °C is designated. Given the nature of the sample 515 

collection, it is possible and advised to collect samples at equipped facilities where these 516 

protocols can be applied to minimize metabolic alterations which may occur during e.g. 517 

sample transport.  518 

To demonstrate the application potential of LA-REIMS saliva fingerprinting in a clinical 519 

context, saliva material was collected from children and adolescents (6 to 16 years), 520 

which were classified according to weight status, using the IOTF-score (z-score for BMI) 521 

(IOTF of 0 for normal weight, 1 for overweight, and 2 for obesity).  522 

<CRITICAL> Fresh samples should be kept frozen at all times to avoid metabolic 523 

alterations. Thawing of the material for LA-REIMS analysis should be performed at 4-6 °C. 524 

• Urine samples: For development of the LA-REIMS procedures as well as to perform rapid 525 

fingerprinting in a context of clinical diagnostics, urine samples were collected from 526 

study participants  that provided written, informed consent (or parents in case of 527 

minors), following approval of the study by the ethics committee. For the examples, 528 

described in this protocol, samples were collected under University Hospital Ghent 529 

Ethical Committee (EC 2017/1634). 530 
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Urine samples can be collected in a plastic 100-mL container in case of adults or children 531 

that are neat, whereas alternative tools need to be used in case that children are not 532 

neat; e.g. Sterisets Newcastle Urine Collection Packs (Sterisets Medical Devices, 533 

Portugal). With respect to the latter, urine can be extracted from these packs using a 534 

syringe. Samples should be stored as soon as possible at -20 °C (at the participant’s 535 

home) or -80 °C (at equipped facilities). If transport is needed, this should be realized 536 

under cooled conditions (0 °C or lower; using ice packs, dry ice, or liquid nitrogen). 537 

<CRITICAL> It is important that urine is not contaminated with stool material when 538 

collecting from children that are not neat. <CRITICAL> Samples should be kept frozen at 539 

all times to avoid metabolic alterations. Thawing of the material for LA-REIMS analysis 540 

should be performed at 4-6 °C.  541 

Sputum: For development of the LA-REIMS procedures, sputum samples were obtained 542 

from the Royal Brompton Hospital as part of routine sample collection for monitoring of 543 

cystic fibrosis patients. Sputum can be collected as either spontaneous or induced 544 

dependent on clinical guidelines and practice in sterile universal containers. Samples can 545 

be treated with Sputasol to allow easier handling or analysed neat. They can further be 546 

analysed immediately upon sampling or stored at -80 °C. <CRITICAl> Samples should be 547 

kept frozen at all times to avoid metabolic alterations. Thawing of the material for LA-548 

REIMS analysis should be performed at 4-6 °C. ! Caution For safety purposes, samples 549 

should not be collected from patients with positive results or suspected symptoms of 550 

tuberculosis, unless samples can be stored, processed, and analysed in Category III 551 

biohazard facilities. If samples contain blood, they should not be analysed and should be 552 

disposed of immediately. 553 
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• Human milk: For development of LA-REIMS procedures, human milk samples were 554 

collected from a cohort of breastfeeding dyads with nursling ages ranging between 3 to 555 

24 months. For this purpose, samples were collected under a sub-project (approval 556 

number R18006) of the Breastmilk Epigenetic Cohort Study under the Imperial College 557 

Healthcare Tissue Bank (HTA licence 12275), which received ethical approval from the 558 

Wales Regional Ethics Committee (reference 17/WA/0161). Participants should be free 559 

to choose method of expression (hand, electric, or manual pump) but sterility of 560 

collection equipment (pump, tubing, containers) should be achieved through steam 561 

sterilization following manufacturers' procedures. Samples should be collected into 562 

sterile containers suited to the volume of collected human milk sample. Samples can be 563 

analysed immediately (within 60 min of collection) or stored at -20 °C or -80 °C 564 

depending on availability of facilities. <CRITICAL> Samples should be kept frozen at all 565 

times to avoid metabolic alterations. Thawing of the material for LA-REIMS analysis 566 

should be performed at 4-6 °C. 567 

 568 

Reagents 569 

• Isopropylalcohol (LC-MS grade, Sigma Aldrich, cat. no. 34863) 570 

• Ultrapure water (0.055 μS/cm, purchased or obtained from water-purification 571 

systems such as Sartorius Arium 661 UV, Sartorius, Germany) 572 

• Sodium formate calibration solution (see ‘Reagent set-up’ section) 573 

• 0.5 mM sodium hydroxide in 90:10 isopropylalcohol /water (v/v) (Waters, cat. no. 574 

186007052) 575 

• Formic acid > 99.0% (LC-MS grade, Fisher Scientific, Sigma Aldrich, cat. no. 117-50) 576 

• Methanol (LC-MS grade, Sigma Aldrich, cat. no. 646377) 577 
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 578 

External standards (can be added to the isopropylalcohol solvent matrix) 579 

Depending on the experimental set-up, one or multiple compounds may be co-infused with 580 

the isopropylalcohol solvent matrix during analysis. Details on how to prepare the solutions 581 

are in the section ‘Reagent set-up’. 582 

• (Optional) leucine-enkephalin (Waters, cat. no. 186006013) 583 

• (Optional) palmitic acid-d31 (Sigma Aldrich, cat. no. 366897) 584 

• (Optional) 1,2-dimyristoyl-d54-sn-glycero-3-phosphocholine (Sigma Aldrich, cat. no. 585 

711047) 586 

 587 

Equipment  588 

Personalized protective equipment (PPE)   589 

• Nitril gloves (EcoSHIELDTM Eco NitrilePF 250, NOVOLAB NV, Belgium)  590 

• Laser Safety Glasses LG16 4.00, 41% Visible Light Transmi Commodity: 9004 591 

9010, RoHS: A (compliant 2011/65/EU) (Thorlabs GmbH, Germany)  592 

General lab equipment  593 

• Wipe away® wipes  594 

• Micropipettes (100-1000 µL, Eppendorf, Germany)  595 

• Volumetric beakers (VWR, Borosilicate glass 3.3, 100-250-600-1000 mL)  596 

• Cotton cleaning swabs (Biolab, Hungary, cat. no. CTA90003)  597 

• Microscope blank glass slides (Marienfeld, Germany, cat. no. 1000000)  598 

• Microtiter plates (NOVOLAB NV, Belgium, cat. no. 32004)  599 

• Elmasonic P® ultrasonic bath (Elma, Germany, cat. no. 101 3737) 600 

Laser set-up  601 
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• OpoletteTM HE2940 pump laser (OPOTEK, LLC, USA) consisting of an Nd:YAG laser, 602 

• steering optics, optical parametric oscillator (fixed at 2940 nm), wavelength 603 

separation optics and laser power supply   604 

• Power meter (Quantel, USA)  605 

• Aluminium breadboard 200 x 200 x 12.7 mm and M6 Taps (Thorlabs GmbH, 606 

Germany)  607 

• Fee space optics, enfolding a line of metallic or gold-coated mirrors 608 

(OptoSigma Global Top, France)   609 

• Fixed Lens holders LHG RoHS W4148 (Sigma-koki, Japan), kinematic mirror holders 610 

RoHS W4002 (Sigma-koki, Japan)  611 

• Pedestal bases (45.8 mm) onto which lenses and mirrors are mounted using pedestal 612 

clamps RoHS W6039 (Sigma-koki, Japan)  613 

• Clamps and damped rods for every mirror and/or lens (using a  65x65mm M6 614 

plateau) (Sigma-koki, Japan) 615 

• Z Axis Aluminium translation stages (65 x 65 mm) (Sigma-koki, Japan)  616 

• CAF2 Plano convex lens RoHS W3189 (Thorlabs GmbH, Germany)  617 

• PEEK tubing (0.010 in. ID; 30 cm, Thermo Fisher Scientific, USA, cat. no. 10574855) 618 

• Cytiva PEEK Connectors 1/16 in. Luer (Thermo Fisher Scientific, USA, cat. no. 619 

11370232) 620 

REIMS  621 

• Polytetrafluorethylene tubing (2.5 m, 3.2 mm O.D., 1.6 mm I.D., Sigma Aldrich, cat. 622 

no.  623 
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58699) connected to the REIMS interface by means of a T-shaped connector 624 

piece (prototype, Waters Research Center, Hungary) 625 

• REIMS source (prototype, Waters Research Center, Hungary) with a 20 cm inlet 626 

capillary of 0.7 mm I.D. mounted onto the housing of the T-shaped connector piece 627 

by a length of 0.1 mm I.D. PEEK tubing to a 10 mL syringe 628 

• 10 mL glass syringe (Hamilton, USA)  629 

• Harvard 11 Elite syringe pump (Harvard Apparatus, USA) for isopropylalcohol 630 

infusion (enclosing external calibration / lock mass compound) 631 

• Computer (64-bit operating system, 4 GB RAM, Windows 10, Lenovo, China)  632 

• Xevo G2-XS Quadrupole Time-of-Flight mass spectrometer (Q-TOF-MS) (Waters  633 

Corporation, UK)  634 

 635 

Software  636 

1. MassLynxTM (v4.2, Waters) 637 

2. Progenesis® Bridge (v1.0.29, Waters)  638 

3. Progenesis® QI (V2.1, Waters) 639 

4. SIMCA (v15, Sartorius) 640 

 641 

Reagent set-up 642 

Preparation of sodium formate calibration solution 643 

1. Prepare 1 mL of 10% formic acid/aqueous solution by mixing 900 μL of ultrapure 644 

water and 100 μL LC-MS grade formic acid; sonicate for 5 min (40 kHz, fixed 645 

frequency, no heating). 646 
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2. Mix 100 μL of 10% formic acid/aqueous solution to 30 mL of 0.5 mM sodium 647 

hydroxide in 90:10 isopropylalcohol/water (v/v) and transfer to an amber glass vial; 648 

sonicate for 5 min (40 kHz, fixed frequency, no heating). 649 

■ PAUSE POINT The sodium formate solution can be stored at 4 °C for up to 3 months.  650 

 651 

(optional) Leucine-enkephalin in isopropylalcohol  652 

Can be used as an external standard for analysis in both positive and negative ionization 653 

mode7. 654 

1. Add 7.5 mL of ultrapure water to a 3 mg bottle of leucine-enkephalin. 655 

2. Recap, vortex for 30 s at 14 x g and sonicate for 5 min; the resulting 400 ng/μL 656 

solution can be stored at -20 °C for up to 3 months. 657 

3. Transfer 5 μL of 400 ng/μL leucine-enkephalin solution to a 50 mL glass vial, add  658 

20 mL of isopropylalcohol to obtain a 0.1 ng/μL stock solution. Sonicate for 5 659 

minutes (40 kHz, fixed frequency, no heating). Label and store at -20 °C for up to 660 

one month. 661 

4. Transfer 1 mL of 0.1 ng/μL leucine-enkephalin solution to 9 mL of 662 

isopropylalcohol stored in an amber glass vial to obtain a 10 ng/mL solution; 663 

sonicate for 5 min (40 kHz, fixed frequency, no heating). 664 

■ PAUSE POINT The resulting solution can be used directly in the experiment or stored 665 

at -20 °C for up to one week. 666 

 667 

(optional) Palmitic acid-d31 in isopropylalcohol   668 

Can be used as external standard for negative ionization only. In case of alternating between 669 

positive and negative ionization mode during LA-REIMS analysis, it is possible to add 1,2-670 
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dimyristoyl-d54-sn-glycero-3-phosphocholine to this solution to also cover positive 671 

ionization13. 672 

1. Weigh 1 mg of palmitic acid-d31 into a 5 mL glass vial. 673 

2. Add 1 mL of ultrapure water, vortex for 30 s at 14 x g and sonicate for 5 min (40 674 

kHz, fixed frequency, no heating); the resulting 1 mg/mL stock solution can be 675 

stored at -20 °C up to 3 months. 676 

3. Transfer 50 μL of 1 mg/mL stock solution into a 10 mL glass bottle, add 9.95 mL of 677 

isopropylalcohol; sonicate for 5 min (40 kHz, fixed frequency, no heating).  678 

■ PAUSE POINT The resulting 5 ng/μL solution can be used for sample analysis or stored 679 

at -20 °C for up to one month.  680 

 681 

(optional) 1,2-dimyristoyl-d54-sn-glycero-3-phosphocholine in isopropyl alcohol.  682 

Can be used as external standard for positive ionization only. In case of alternating between 683 

positive and negative ionization mode during LA-REIMS analysis, it is possible to add palmitic 684 

acid-d31 to this solution to also cover negative ionization13. 685 

 686 

1. Weigh 10 mg of 1,2-dimyristoyl-d54-sn-glycero-3-phosphocholine in a 10 mL glass 687 

vial. 688 

2. Add 10 mL of methanol, vortex for 30 s at 14 x g and sonicate for 5 min (40 kHz, 689 

fixed frequency, no heating); the resulting 1 mg/mL stock solution can be stored 690 

at -20 °C up to 3 months. 691 

3. Transfer 100 μL of 1 mg/mL stock solution into a 10 mL glass bottle, add 9.9 mL of 692 

isopropylalcohol; sonicate for 5 min (40 kHz, fixed frequency, no heating).  693 
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■ PAUSE POINT The resulting 100 ng/μL solution can be used for sample analysis or 694 

stored at -20 °C for up to one month. 695 

 696 

Equipment set-up 697 

MS parameters 698 

Use the following general settings for the Waters Xevo G2-XS QToF instrument. 699 

Instrument parameters 

Mass range, Da 50-1200

Analyser mode Sensitivity 

Data format Continuum 

Acquisition start time, min 0 

Acquisition end time, min 0.5 (manual sampling); 0.3 (automated sampling) 

Target enhancement Off 

 700 

Use the following optimized set-up parameters for the Waters Xevo G2-XS QToF instrument 701 

combined with MID-IR laser (Q-switch delay time) or CO2 laser (laser power and pulse 702 

values) for the specified biofluids in positive (+) and negative (-) ion polarity modes. 703 

Abbreviations used; NA (not applicable).  704 

 Urine Feces Saliva Plasma Sputum Human Milk

Polarity + / - + / - + / - + / - + / - + / - 

Solvent flow 

rate, mL/min 
0.30 0.15 0.12 / 0.20 0.30 / 0.20 0.25 0.25 

Cone voltage, V 25 40 / 70 20 / 45 30 80 80 
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Heater bias 

voltage, V 
25 40 75 / 70 40 50 50 

Laser wave-

length, µm  
2.94 2.94 2.94 2.94 10.64 10.64 

Laser Q-switch 

delay time, µs 
185 180 165 / 180 170 / 165 NA NA 

Laser power, W NA NA NA NA 2.0 3.5 

Pulse time, ms NA NA NA NA 40 40 

Scan time, s 0.7 / 0.5 0.3 0.5 0.7 1.0 1.0 

 705 

Procedure  706 

Set-up of the sample holder or container ● Timing 1-2 min per sample 707 

1. Transfer the samples to an appropriate sample holder or container. Sample handling will 708 

be different depending on the adopted sampling approach (manual or automated) as 709 

well as on the sample matrix (liquid or semi-fluid). For manual sampling of liquids and 710 

semi-fluids (A and B) multiple sample slides can be prepared in advance, but preferably 711 

not more than 10 samples at a time, as the thin sample layer will dry-out within 20 to 30 712 

min under ambient conditions. For automated sampling, the position of the samples 713 

within the 96-well plate corresponds to the order within the acquisition sequence (C and 714 

D). If more than one well plate is to be analysed, it is recommended to cover the well 715 

plates with a self-adhesive polyester foil to reduce sample evaporation pending analysis.  716 

A. Manual sampling of liquids  717 

Using a 100 μL pipet, transfer 20 to 50 μL of liquid sample (e.g. plasma, urine, saliva, human 718 

milk, sputum treated with Sputasol) to the glass microscope slide. Use separate slides for 719 
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each sample.  720 

B. Manual sampling of semi-fluids 721 

Using a disposable sterile spatula, apply a thin layer (approximately 50-80 mg) of semi-fluid 722 

sample (e.g. feces, untreated sputum) to the microscope slide and distribute evenly.  723 

C. Automated sampling of liquids 724 

Using a 100 μL pipet, transfer 100 μL of liquid sample (e.g. plasma, urine, saliva, human milk, 725 

sputum treated with Sputasol) to its designated well within a 96-well plate.  726 

D. Automated sampling of semi-fluids 727 

Using a disposable sterile spatula, fill the sample well with semi-fluid sample (e.g. feces, 728 

untreated sputum) to approximately half of the well’s height (80 to 100 mg of sample 729 

generally suffices). 730 

 731 

Set-up of the laser ● Timing 10-15 min  732 

2. The authors of this protocol had access to an Nd:YAG MIR OPO laser and CO2
 laser for 733 

their experiments. Both lasers have been demonstrated suitable to achieve ablation of 734 

liquid and semi-fluid biological material. Preparation of the lasers for sample ablation is 735 

detailed in option A and option B, respectively.  736 

 737 

A. MIR OPO laser  738 

(i) On the front panel of the laser pump power supply, turn the safety key to the ‘On’ 739 

position (45° clockwise).  740 

(ii) The LED indicators within the water reservoir level window will light up, ensure that 741 

the water level is above the window minimum indication. 742 
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(iii) In the system menu of the laser control panel, choose ‘system settings’ and check the 743 

coolant temperature readback. Wait approximately 5 to 10 min until the coolant 744 

temperature rises up to 37.5 °C. 745 

(iv) In the Q-switch configuration menu of the laser control panel, set the Q-switch delay 746 

time to the optimized value for the selected matrix (‘Equipment set-up’ section). 747 

(v) In the Q-switch configuration menu, set the Q-switch repetition rate to F/01 (20 Hz). 748 

This value is standard for all described methods independent of the matrix.  749 

B. CO2 laser 750 

(i) Ensure that the laser hollow core fibre is connected correctly to both the laser unit 751 

and the focusing system and that there is no visible damage to the fibre or 752 

connecting points. 753 

(ii) Turn on the front panel of the laser and ensure that any connecting gas supplies for 754 

cooling are turned on to the correct pressure setting. 755 

(iii) The laser will run through a self-check procedure to ensure it is operating at the 756 

appropriate level. Any errors will be communicated on the display screen for user 757 

troubleshooting. 758 

(iv) With the laser on ‘Standby’ mode, adjust the laser operating settings to the required 759 

pulsatile mode, pulsatile duration, output power, and gas flow pressure. 760 

(v) On the display screen, switch the laser to ‘On’ mode and wait 10 s to ensure no 761 

system error messages appear. 762 

 763 

Connecting REIMS sampling tube, solvent line and MS source ● Timing 5-10 min 764 
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3. Fix one end of the PTFE transfer tube 1 cm above and 3-4 mm to the side of the laser 765 

focus point on the sampling surface (to check the position of the laser focus point, follow 766 

steps 2.1 to 2.8. as described in Box 2). 767 

4. Using PEEK fitting (¼-28 flangeless nuts for 1/8” OD tubing), connect the other end of the 768 

PTFE transfer tube to the T-piece placed at the end of the ion transfer capillary in the 769 

REIMS source (Fig. 4b). 770 

5. Fill the 10 mL glass Luer-lock syringe with isopropylalcohol (for isopropylalcohol 771 

containing reference external standards follow ‘Reagent set-up’ section). 772 

6. Use Cytiva Luer PEEK Connectors to connect the syringe to the PEEK tubing; use two-773 

piece PEEK fittings with ferrules to connect the solvent live with the T-piece at the level 774 

of the MS source (Fig. 4b).  775 

 776 

System preparation and optimization ● Timing 20-25 min 777 

7. On the front panel of the solvent pump, set the solvent flow rate according to the 778 

optimized method parameters per sample matrix and chosen polarity (‘Equipment set-779 

up’ section), and turn on the flow by pressing the ‘Run’ button. 780 

8. Observe the MS signal from the solvent flow on the MassLynxTM tune page. Record the 781 

blank solvent signal and compare the spectrum profile with the blank solvent signal from 782 

a previous experiment.  783 

 ? TROUBLESHOOTING  784 

9. (Optional) If using external standards within the isopropylalcohol solution, check if the 785 

m/z-peaks of these external standards are clearly visible within the solvent spectrum on 786 

the MassLynxTM tune page. 787 
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10. Follow the procedure described in the ‘Sample analysis’ section (step 30 A and B), 788 

analyse 10 eQC samples, respectively, in negative and positive ion mode. This additional 789 

measure will ensure conditioning of the instrument with the matrix-specific ions and 790 

reduce MS signal variation over time during subsequent analysis of biological samples.  791 

 792 

External calibration of the REIMS ● Timing 40 min 793 

▲ CRITICAL STEP The instrument should be calibrated daily to ensure high mass accuracy.  794 

11. Fill the glass syringe (10 mL Fixed Luer Lock Tip Syringe, SGE, cat. no. 008970) with 0.5 795 

mM sodium formate calibration solution. 796 

12. Initiate MS scanning by pressing the ‘On’ (‘I’) button on the MassLynxTM tune page.  797 

13. On the front panel of the solvent pump, set up the solvent flow rate at 0.2 mL/min and 798 

initiate  the flow by pressing the ‘Run’ button. 799 

14. Wait until the sodium formate spectrum is visible and stable on the MassLynxTM tune 800 

page (multiple high peaks distributed across entire m/z-range). 801 

15. Select the ‘MS console’ tab in the MassLynxTM tune page and subsequently the 802 

‘IntelliStart’ tab. Set the system to ‘Configuration mode’ by choosing it in the ‘Configure’ 803 

drop-down menu at the top of the page. 804 

16. Tick the empty box next to the ‘Create Calibration’ option on the instrument 805 

configuration panel and press ‘Start’.  806 

17. The step-by-step create calibration wizard algorithm will appear on the screen. Press 807 

‘Create Profile Editor…’, then select ‘File’ drop-down from the pop-up window and press 808 

‘New’ to define a new calibration profile. 809 

18. Populate the ‘New calibration profile window’ by defining the profile name, setting the 810 

mass range from 50 to 1200 Da and the calibration type as ‘Assisted’. 811 



  
 

 45

19. In the calibration profile window click ‘Edit...’ next to the ‘Positive polarity’ section. In the 812 

new window choose ‘Enabled’ as an option for calibration reference compound and 813 

select sodium formate in the drop-down menu. 814 

20. Repeat step 15 for the ‘Negative polarity’ section within the calibration profile window. 815 

■ PAUSE POINT Once created, the calibration profile can be updated each time a new 816 

instrument calibration is performed by resetting the already calibrated profile through 817 

the ‘Edit’ drop-down menu in the Calibration profile editor. The reset profile will save all 818 

defined calibration settings but lacks calibration data, so it can be used for new 819 

calibration (the ‘green tick’ next to the calibration profile will change to ‘orange triangle’ 820 

in the Calibration Profile pull down menu).  821 

21. Choose both sensitivity and resolution mode for positive and negative polarity 822 

calibration by ticking the corresponding boxes in the Calibration set-up wizard page.  823 

22. Check both boxes (‘Display Report’ and ‘Make Calibration Profile Active’) in the ‘Options’ 824 

section. 825 

23. Do not change any settings on the other pages of the Create Calibration wizard sequence 826 

and click the ‘Next’ button on the bottom of every page to reach the end of the 827 

sequence. 828 

24. Press the ‘Start’ button at the end of the Create Calibration wizard sequence. The 829 

calibration process will be initiated by the software. 830 

25. At the end of the calibration process, the Calibration report for evaluation pops up. All 831 

peaks in the acquired datafile should be matched with the reference file for sodium 832 

formate (100% peaks detected), the RMS residual mass and 95% confidence band should 833 

be below 5 ppm mass deviation.   834 
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26. If the abovementioned criteria for good system calibration are met, accept the 835 

calibration report by clicking on the green ‘tick’ symbol above on the Calibration report 836 

page. Continue the evaluation for both modes (sensitivity and resolution) and both 837 

polarities (negative and positive). 838 

27. When calibration has been successfully finalized, a new calibration file will be 839 

automatically saved and uploaded on the MS control panel. 840 

28. Remove the remaining calibration solution from the syringe and replace the solvent to 841 

isopropylalcohol, start the solvent pump and initiate the MS acquisition. Flush 842 

approximately 20 min to remove the remaining calibration solution from the system. 843 

29. After approximately 20 min, check the tune page MS spectrum; no additional peaks aside 844 

from the isopropylalcohol ions should be present within the spectrum TIC. 845 

 846 

Sample analysis 847 

30. Depending on whether a manual or automated sampling analysis will be performed, 848 

follow the steps in options A or B. 849 

A. Manual analysis ● Timing 30 s/sample (per ionization mode) 850 

(i) In the MassLynxTM software window, initiate MS acquisition by selecting all 851 

samples in the sample sequence that should be analysed within one batch 852 

and press the ‘Run sequence’ button on top of the page. 853 

(ii) Activate the laser by pressing the ‘Start’ button next to the flash lamp and Q-854 

switch indicators on the laser control panel. 855 

(iii) Place the microscope slide, carrying the sample, under the laser focus point 856 

for ablation; remove after 3 s. 857 
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(iv) (Optional) Repeat step (iii) to generate several replicates. If you do this, 858 

record 3 to 4 s (blank background signal) between burns for optimal peak 859 

resolution. 860 

(v) Repeat steps (i) to (iv) for any other sample to be analysed.  861 

▲ CRITICAL STEP Routinely clean the laser focusing lens from the side of ablation with a 862 

cotton bud dipped in ethanol every 5 to 10 burns  depending on the normal rate of 863 

contamination. Clean the focusing lens in a similar fashion whenever the intensity of 864 

acquired spectra decreases with more than 10%. 865 

(vi) (Optional) Repeat steps (i) to (v) for all samples when analysing the samples in 866 

the opposite polarity mode, changing to the appropriate experimental 867 

settings (‘Equipment set-up’ section). 868 

B. Automated analysis ● Timing 23 s/sample (per ionization mode) 869 

(i) Position the microtiter plate(s), containing the samples, on the sampling 870 

surface. 871 

(ii) Ensure that the laser focus point lies in the middle of the first well (check with 872 

the alignment diode beam, see Steps 1-8 for external optics alignment 873 

verification as described in Box 2). 874 

(iii) Within the laser controlling software, the following experimental sequence 875 

should be programmed: a 3-s burn followed be a 20.6-s cooldown period.  876 

(iv) Within the stage controlling software, define the number of sample-filled 877 

wells to be analysed (i.e. the number of repetitive movements that the stage 878 

has to perform to position every sample-filled well under the laser focus 879 

point). The moving stage ‘move and wait’ cycle timing should correspond to 880 

the laser sequence program cycle of 23.6 s). 881 
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(v) Initiate the autosampler robot sequence. 882 

(vi) After 5 s initiate the MS instrument acquisition sequence. This will set the 883 

burn ‘retention time’ at approximately 15 s in the acquisition file.  884 

▲ CRITICAL STEP Clean the laser focusing lens from the side of ablation with a cotton bud 885 

dipped in ethanol every 10 to 15 burns.  886 

(vii) (Optional) Repeat steps (iv)-(vii) for all samples when analysing the samples in 887 

the opposite polarity mode, changing to appropriate experimental settings 888 

(‘Equipment set-up’ section). 889 

 890 

Computational analysis ● Timing 1 h/500 samples 891 

31. Load the acquired spectra into the appropriate software. 892 

▲ CRITICAL STEP Data collected on the LA-REIMS instrument (Waters) are processed 893 

sequentially by Progenesis®  Bridge (v1.0.29, Waters) and Progenesis®  QI (V2.1, 894 

Waters); see Box 3 Steps 1-11. 895 

32. Apply pre-processing to the spectra, including noise removal, baseline subtraction, 896 

selecting burns and peak picking. 897 

33. Load the peak lists (m/z-features) into the appropriate software. 898 

▲ CRITICAL STEP The choice of software will depend on the classification modelling 899 

approach selected (commercial, open-source software) and compatibility with the 900 

output format after pre-processing. Here, data collected from Progenesis®  QI (v2.1, 901 

Waters) are loaded into SIMCA (v15, Sartorius); see Box 3 Steps 12-22. 902 

34. Select features that show statistical and significant differences in the discriminative 903 

analysis. 904 

 905 
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Cleaning and maintenance procedures ● Timing 1.5 h 906 

35.  After the experiment, and as part of troubleshooting, you will need to clean and 907 

maintain the intruments. Follow the guidelines in Table 1 for maintenance methods and 908 

frequency rate for each hardware component of the LA-REIMS set-up. 909 

 910 

Table 1 ⏐Cleaning and maintenance 

Component Method Frequency Considerations 

Beam 

transmission 

(mirror or 

fibre) 

Clean the mirror with 

manufacturer 

recommended solvent and 

the fibres by flushing with 

nitrogen or helium  

As necessary based 

on laser power 

output monitoring. 

Replacement of fibre 

should be in line 

with manufacturer 

recommendations or 

as necessary based 

on laser power 

output monitoring. 

Beam focusing 

lens 

Clean with manufacturer 

recommended solvent, 

absorbed into non-scratch 

material swab/tissue. 

Daily or as necessary 

based on laser 

power output 

monitoring. 

Analysis of samples 

such as feces may 

result in debris 

build-up on lens and 

requires more 

frequent cleaning. 

Aerosol 

transfer line 

It is difficult to remove 

solvent from the line, so if 

it is dirty, the dirty section 

Trimming of 2 cm 

from the ends is 

recommended daily 
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should be removed. First 

trim 2 cm from the ends, 

and if this does not 

improve things, replace 

the PTFE tubing in its 

entirety.   

with replacement of 

entire length weekly.

T-piece and 

inlet capillary 

Dismantle the set-up and 

sonicate (40 kHz, ‘Sweep’ 

mode/alterating 

frequency, no heating) in 

isopropylalcohol/water 

(50:50 v/v) for 10 min 

followed by air drying for 

30 min. 

Daily. Cleaning solvent 

may be altered to 

remove particular 

chemical 

contamination (e.g. 

MS Cleaning 

Solution (Waters, 

cat. no. 186006846) 

or appropriate mild 

soap solution for 

precipitated 

proteins).  

REIMS 

interface 

Dismantle the interface 

and swab the exposed 

parts using methanol using 

non-scratch material 

swab/tissue followed by 

Weekly or as 

necessary if 

contamination is 

detected in 

background signal. 

If venting of the 

instrument and 

recalibration is 

required, this should 

be accommodated in 
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air drying for 30 min. the analytical 

schedule. 

Ion guide (e.g. 

Waters 

StepWave) 

Remove the ion guide 

from the instrument 

housing and clean using 

manufacturer 

recommended routine. 

Typically, 30 min 

sonication (40kHz, ‘Sweep’ 

mode/alterating 

frequency, no heating) in 

MS Cleaning Solution 

(Waters, cat. no. 

186006846), 10 min 

sonication in 

methanol:water (50:50 

v/v) followed by 10 min 

sonication in methanol 

and air drying for 30 min. 

Weekly or as 

necessary if 

contamination is 

detected in 

background signal. 

As venting is 

required, clean the 

ion guide at the 

same time that you 

clean the REIMS 

interface. 

 911 

Troubleshooting  912 

Troubleshooting advice can be found in Table 2. 913 

 914 
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Table 2 ⏐Troubleshooting table   

Step  Problem Possible reason Solution 

Box 2, step 5 While aligning 

the laser beam, 

the green light is 

not visible 

within the 

alignment 

target. 

 

Laser energy output 

is not sufficient to 

activate fluorescent 

photosensitive 

matrix on alignment 

target surface. 
 

Decrease the laser 

Q-switch delay to 

300 µs.  

Box 3, step 1c The number of 

bridged files is 

different than 

the number of 

burns.  

 

 

When less bridged files 

than burns are 

observed, the TIC 

threshold may be set 

too high (only highest 

peaks are recognized). 

In case only one 

bridged file is produced 

after processing, this 

might imply that the 

TIC threshold is either 

too low and all signals 

above the threshold 

Check peak and 

background 

intensities in 10% of 

samples. Make sure 

to include runs at 

the end of the 

experiment as 

intensities might be 

somewhat lower. If 

possible – choose 

one threshold value 

for processing of all 

experimental files 
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are combined in one 

peak or too high and 

only the highest peak is 

detected. In the latter 

case, often samples for 

which none of the 

peaks meet this high 

threshold value will be 

absent from the 

‘processed’ directory.    

within one polarity 

mode. If the 

differences in 

intensities within 

the experiment are 

too large to 

correctly process all 

files with one TIC 

threshold (may be 

noticeable for 100 

and more samples) 

consider dividing 

files into batches.  

 

NOTE:  signal 

intensities differ 

substantially 

between polarities 

within one 

experiment. 

Therefore positive 

and negative data 

should be processed 
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separately with 

separate TIC 

threshold values. 

 

 

Box 3, Step 15c The errors ‘no 

valid values’, 

‘missing 

observation ID’ 

or ‘missing 

variable ID’ pop 

up. 

 

No values present in 

the dataset. 

Check if all 

‘#DIV/0!’, ‘NA’, ‘∞’, 

… values are 

removed from the 

dataset, including 

the header 

information. 

Step 8 While infusing 

pure 

isopropylalcohol, 

the tune page 

spectrum 

displays 

additional m/z 

signals. 

Source, solvent line or 

sample tube may be 

contaminated. 

Perform additional 

cleaning and/or 

change infusion 

solvent. 

 915 

Timing 916 

Step 1, Set-up of the sample holder or recipient: 1-2 min/sample 917 
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Step 2, Set-up of the laser: 10-15 min 918 

Steps 3-6, Connecting REIMS sampling tube, solvent line and MS source: 5-10 min  919 

Steps 7-10, System preparation and optimization: 20-25 min 920 

Steps 11-29,  External calibration of the REIMS interface: 40 min 921 

Step 30A, Manual analysis: 30 s/sample 922 

Step 30B, Automated analysis: 23 s/sample 923 

Steps 31-34, Computational analysis: 1 h/500 samples 924 

Step 35, Cleaning and maintenance: 1.5 h 925 

Box 1, Sample preparation: 0-15 min/sample 926 

Box 2, Laser alignment verification: 20-30 min  927 

Box 3, LA-REIMS data analysis & classification modelling: 1 h/500 samples  928 

 929 

Anticipated results  930 

With this protocol, we provide guidelines to perform rapid LA-REIMS metabolic 931 

fingerprinting of various human biofluids, i.e. saliva, urine, plasma, stool, sputum, and milk. 932 

Hereby, aspects on both sample handling and instrumental set-up are detailed. Using the 933 

outlined procedures, high-quality data for a broad m/z-spectrum (50 – 1200 Da) can typically 934 

be acquired in less than 1 min per sample; including sample loading and inter-sample 935 

equilibration. No significant pre-treatments of the biofluids are needed, with the exception 936 

of saliva. As such, LA-REIMS offers relevant potential for diverse clinical applications, in 937 

which rapid discriminative metabotyping and/or (point-of-care) personalized health care 938 

provision are major objectives. In this section, we discuss the anticipated results as may be 939 

obtained upon biofluid LA-REIMS analysis, with specific elaborations on the generated 940 

molecular fingerprints, the precision of the analysis, and the application potential in a clinical 941 
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context. For this, we chose feces as a semi-fluid and saliva as a real biofluid, as examples for 942 

in-depth illustration of some particular aspects. 943 

 944 

Molecular fingerprints 945 

For all biofluids and semi-fluids, the mass spectra that are generated by LA-REIMS comprise 946 

several hundreds of features across the 50 – 1200 Da m/z scan range, for both negative and 947 

positive ionization mode. In Fig. 5, we show representative molecular fingerprints for saliva, 948 

plasma, urine, stool, milk, and sputum, as obtained from a single burn of a pooled sample (n 949 

= 10).  950 

We did a similar experiment where we analysed the samples by DIMS and have included the 951 

methods and results for this in the Supplementary Discussion. From these results it was clear 952 

that we were able to get a higher metabolome coverages using LA-REIMS. There was also 953 

substantial contamination at the ionization source for DIMS making  robust analysis of large 954 

sample batches problematic. While these problems can be overcome using appropriate 955 

sample pre-treatment for direct infusion MS of biofluids (e.g. saliva, urine, blood) and even 956 

essential for semi-fluids (e.g. feces), this requirement detracts from the pursuit of rapid 957 

(real-time) fingerprinting, as is achieved by LA-REIMS.  958 

For the various matrices, the total number of unique features that could be retrieved by 959 

considering the samples from ten individuals was 3628 for saliva (52.0% of these were 960 

detected in negative ionization mode), 3015 for plasma (47.2% in negative), 3767 for urine 961 

(54.1% in negative), 2078 for feces (65.9% in negative), 3065 for milk (31.6% in negative), 962 

and 2039 for sputum (35.1% in negative).  963 

In-depth analysis of the metabolic fingerprints shows that the lower m/z-region of 50 – 400 964 

Da generally contributes the most to the achieved metabolome coverage (number of 965 
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detected features) for negative ionization mode, but the m/z region of 200 – 600 Da 966 

contributes the most for positive ionization mode (Fig. 6). This most likely relates to the 967 

specific metabolome composition of the assessed matrices and the number of metabolite 968 

representatives for the various chemical classes (i.e., reflected by various functional groups 969 

and associated ionization behaviours). Also UHPLC-HRMS analysis revealed specific m/z-970 

patterns, corresponding to the ionization mode, as e.g. illustrated for saliva by Wijnant et al. 971 

(2020)13. 972 

   973 

Taking into account the absolute metabolome coverage per matrix and making the 974 

comparison between matrices, it may be noted that the metabolome of feces and milk 975 

contain a relatively low proportion of high-weight features (> 800 Da), whereas the sputum 976 

metabolome encompass a relatively low proportion of low-weight features (< 200 Da). It has 977 

indeed been described that sputum especially contains a high fraction of various lipid 978 

species, including highly abundant sphingolipids such as sphingomyelins, ceramides, and 979 

lactosylceramides43. In human milk, a high abundance of various low- to medium-weight 980 

metabolites have been reported, such as oligosaccharides, amino acids and derivatives, and 981 

fatty acids and associated metabolites44. For feces, the defined metabolome composition 982 

may largely be determined by the metabolic activity of the gut microbial community, 983 

including the metablization of large and complex structures45.  984 

 985 

The above-mentioned data were obtained for each biofluid based on a single burn. A typical 986 

burn for positive and negative ionization is presented in Fig. 3. Taking into account the scan 987 

time (see ‘Equipment set-up’ section), the total number of scans acquired per burn varied 988 

between 4.2 scans (plasma) and 10.0 scans (feces). A higher background level was generally 989 
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obtained in positive ionization mode7 for all matrices, as displayed for feces (Fig. 3). It was 990 

verified that especially m/z-features < 350 Da contributed to this background signal.  991 

 992 

Precision 993 

As a major parameter to assess the performance quality, the precision of the LA-REIMS 994 

method was verified for feces as a semi-fluid representative and saliva as a real biofluid. 995 

Repeatability was evaluated based on the repetitive (n = 3) laser ablation of a single sample 996 

as well as the sequential analysis of ten different samples from the same sample pool. 997 

Reproducibility was assessed for three consecutive analysis days whereby ten sample 998 

aliquots were analysed per day, prepared from the same sample pool, stored at -80 °C, and 999 

all subjected to one freeze-thaw cycle. 1000 

 1001 

For the repeatability that was assessed by subjecting a single sample to three consecutive 1002 

ablation events, it was observed that the achieved metabolome coverage was highly 1003 

repeatable across the various burns and this for both ionization modes and matrices (Table 1004 

3, minimum of 84.5% congruence). With respect to the total ion current (TIC), it was noted 1005 

that significant differences may occur from burn to burn (Table 3, CV% up to 45.5%). This is 1006 

evidence that TIC-based data normalization is essential to attain high-quality LA-REIMS 1007 

metabolomics datasets. Indeed, by applying TIC-based normalization, high signal 1008 

repeatability was calculated with ≥ 92.5% of the features found in feces having a CV ≤ 30%46; 1009 

the corresponding value for saliva was ≥ 80.9%. Based on the achieved metabolome 1010 

coverages that were highly similar across burns and the high signal repeatability upon TIC-1011 

based normalization, acquisition of representative LA-REIMS metabolic fingerprints is 1012 

possible based on one burn only.  1013 
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 1014 

Table 3 ⏐Evaluation of the short-term reproducibility, based on repetitive laser ablation (n 

= 3) of a single sample. Abbreviations used; CV (coefficient of variance), TIC (total ion 

current). 

 Unique features within  

 each burn (%)  

Average TIC ± CV%  

 across burns  

Percentage of 

features with CV% 

≤ 30%  

 1st 

burn 

2nd

burn 

3rd 

burn 

Feces              

  Positive ionization   9.4  4.1 6.1 7.8e7 ± 28.1 92.5  

  Negative 

ionization  

3.7  0.4 4.3 3.8e8 ± 45.4 96.4  

  Merged polarities  5.4  1.6  4.8     95.5  

      

Saliva              

  Positive ionization   2.6  1.7  1.5  3.6e8 ± 7.7  83.4  

  Negative 

ionization  

0.5  0.2  1.3  1.9e8 ± 45.5  80.9  

  Merged polarities  1.5  0.9 1.4  82.0  

 1015 

Evaluation of the intra-day repeatability for the ten consecutive sample analyses was 1016 

achieved by assessing the similarity of the molecular profiles in terms of metabolome 1017 

coverage and by calculating the CV% for the TIC-normalized feature abundances. For feces 1018 
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and saliva, metabolome coverage was considered highly repeatable in terms of number of 1019 

features detected  (Table 4). Moreover, the CV% as determined for the TIC-normalized 1020 

features’ abundances indicated that 71.8% of the fecal features and 88.9% of the salivary 1021 

features meet the 30% CV-threshold, typically used in metabolomics analysis46. Inter-day 1022 

repeatability (i.e. the reproducibility) results were generally quite similar to those obtained 1023 

for the intra-day repeatability assessment, indicating that high-quality data acquisition by 1024 

LA-REIMS can be actualized for both biofluid and semi-fluid analysis over the course of 1025 

several days (Table 4). Hereby, internal QC-samples can be used as an efficient strategy to 1026 

adjust for possible instrumental variation (LOESS-based normalization).  1027 

It should be noted, however, that for feces in positive ionization mode, only 38.9% of the 1028 

detected features had an acceptable CV ≤ 30%. This may partially relate to the fact that a 1029 

higher noise level is observed in positive ionization mode, which may somewhat hamper 1030 

reproducible analysis.In addition, microbial enzymatic activity may reactivate after preparing 1031 

the fecal slurry, as a result of which the metabolic composition of the pooled sample may be 1032 

altered.  1033 

 1034 

Table 4 ⏐ Evaluation of the short-term repeatability (10 samples, intra-day) and long-

term reproducibility (3 days, every day 10 samples). Abbreviations used; CV (coefficient 

of variance).  

  Short-term repeatability 

(10 samples) 

Long-term reproducibility 

(3 days, 10 samples per day) 

  Average 

number of 

Percentage of 

features with CV 

Average 

number of 

Percentage of 

features with 
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features ± CV% ≤ 30% features ± CV% CV ≤ 30% 

Feces         

  Positive 

ionization  

546 ± 3.8 67.9  528 ± 6.5 38.9 

  Negative 

ionization 

1217 ± 3.0 73.5 1193 ± 3.8 70.3 

  Merged 

polarities 

1765 ± 2.2 71.8  1721 ± 3.4 66.6 

          

Saliva         

  Positive 

ionization  

1079 ± 3.2 82.6  1090 ± 2.4 78.8 

  Negative 

ionization 

1278 ± 0.5 94.3  1178 ± 0.4 88.7 

  Merged 

polarities 

2357 ± 1.4 88.9  2284 ± 2.3 82.6 

 1035 

Classification model  1036 

To demonstrate the application potential of LA-REIMS for rapid fingerprinting of bio/semi-1037 

fluids and to substantiate the robustness of the methodology, this section describes two 1038 

example clinical cases, i.e. type 2 diabetes and overweight/obesity. For these cases, LA-1039 

REIMS discriminative fingerprinting according to health status was pursued by considering, 1040 

respectively, a semi-fluid (feces) and real biofluid (saliva).   1041 

 1042 
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Based on the fecal LA-REIMS fingerprints, a valid two-class OPLS-DA model was established 1043 

to discriminate between individuals with type 2 diabetes and those with normal glycaemic 1044 

state (i.e. euglycemia). Also, the PCA-X score plot (Fig. 7) showed some segregation of 1045 

samples according to health status. The OPLS-DA model (Fig. 7) was validated with a CV-1046 

ANOVA p-value of 1.93e-17, valid permutation testing, and R2(X) of 0.230, R2(Y) of 0.946 and 1047 

Q2(Y) of 0.734. Moreover, using a five-fold 20%-leave out validation strategy, a general 1048 

classification accuracy of 90.5% was calculated, with a type 2 diabetes sensitivity of 89.5% 1049 

and specificity of 91.7%. Initial classification of individuals according to glycaemic state was 1050 

based on the glycated haemoglobin concentration (HbA1c), thereby implementing a 60 1051 

mmol/mol threshold criterion. A total of 72 individuals took part in the study, whereby 36 1052 

individuals had been assigned a state of type 2 diabetes and 36 individuals a state of 1053 

euglycemia. A detailed explanation on the sample collection, data analysis, data processing 1054 

and interpretation of the results can be consulted in Van Meulebroek et al. (2020)12.  1055 

Whereas the main purpose of this experiment was the rapid discrimination and thus 1056 

diagnosis of glycaemic state based on rapid LA-REIMS metabolic fingerprinting of the semi-1057 

fluid feces, the instrumental platform also allows for some more in-depth interpretation of 1058 

discriminative metabolites (i.e. potential markers). To this end, samples can be subjected to 1059 

MS/MS fragmentation, which offers possibilities for tentative identification. In our study, 1060 

this fragmentation strategy allowed to assign relevant metabolite identities, substantiating 1061 

the method also suited for exploration of the mechanisms involved in pathophysiology. 1062 

Amongst others, 6-hydroxymelatonin, several nicotinamides, D-glucose, biotripyrrin, and 1063 

homocysteine-associated metabolites were tentatively identified as metabolite markers. As 1064 

such, applying LA-REIMS fingerprinting, classification according to glycaemic state was 1065 
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considered possible based on validated supervised modelling, biological qualification of 1066 

tentatively identified metabolite markers, and supportive data from UHPLC-HRMS analysis12. 1067 

  1068 

To assess overweight and obesity in young adolescents (6 to 16 years), saliva samples from 1069 

35 individuals with a healthy weight and 35 individuals with overweight/obesity were 1070 

collected and subjected to LA-REIMS analysis. Hereby, the primary purpose was to achieve 1071 

discrimination according to weight status, as this may enclose interesting opportunities to 1072 

appoint metabolic perturbations according to pathophysiological state and evaluate e.g. the 1073 

contribution of etiological factors and treatment efficacy. Initial adiposity classifications 1074 

were based on BMI z-scores (adjusted BMI for age and sex), following Roelants et al. (2009)47 1075 

and extended international (IOTF) body mass index cut-offs for thinness, overweight, and 1076 

obesity by Cole et al. (2012)48. A valid two-class OPLS-DA model (Fig. 7) could be established, 1077 

which allowed for discrimination between healthy weight (IOTF of 0) and 1078 

overweight/obesity (IOTF ≥ 1). Validation parameters comprised a CV-ANOVA p-value of 1079 

9.01 e-21, valid permutation testing, and an R2(X) of 0.227, R2(Y) of 0.946, and Q2 of 0.808. In 1080 

addition, based on a five-fold 20%-leave out validation strategy, a general classification 1081 

accuracy of 97.1% was achieved, with a sensitivity of 100% and specificity of 94.3%. A 1082 

detailed explanation on the sample collection, data analysis, data processing and 1083 

interpretation of the results can be consulted in Wijnant et al. (2020)13.  1084 

 1085 

 1086 

Reporting summary: Further information on research design is available in Nature Research 1087 

Reporting Summary linked to this article.  1088 

 1089 
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Data availability 1090 

Datasets relevant to our published supporting primary papers can be made available from 1091 

the corresponding author upon reasonable request. The source data for figures is publicly 1092 

available at Figshare repository: 1093 

Fig. 3 https://doi.org/10.6084/m9.figshare.14258423.v1;  1094 

Fig. 5 https://doi.org/10.6084/m9.figshare.14258438.v1;  1095 

Fig. 6 https://doi.org/10.6084/m9.figshare.14258459.v2 1096 
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FIGURES 1247 

Fig. 1. ⏐ A schematic representation of the LA-REIMS workflow. Technical scheme of the 1248 

LA-REIMS set-up whereby a laser beam is focused onto a sample, being placed on either an 1249 
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automated stage equipped to handle 96-well plates or a microscope slide for single samples. 1250 

Rapid heating and evaporation takes place and the resulting analyte-containing aerosol is 1251 

aspirated towards the mass spectrometer under the instrument’s internal vacuum. The 1252 

vapour is mixed with a solvent matrix containing lock mass / external standards and collides 1253 

with a heated collision surface to form gas-phase ions for analysis. Ions are analysed using a 1254 

quadrupole time-of-flight mass spectrometer and the resulting mass spectra are used in 1255 

multivariate and machine learning classification models. 1256 

- Okay. From this figure, I can see why the standards are referred to as “external”. 1257 
- Why are there two arrows for aerosol transfer? 1258 
- I don’t understand the graphic for the flight chamber. 1259 
- To what extent is the multivariate modelling and machine learning specific to this 1260 

type of experiment i.e. specific to LA-REIMS? 1261 

 1262 
 1263 

Fig. 2. ⏐ A flowchart of a standard LA-REIMS biofluid analysis experiment. Summary of 1264 

steps involved in the implementation of LA-REIMS for molecular fingerprinting of biofluids, 1265 

with time indications per step. 1266 

- This is great 1267 

- Consider mentioning the other boxes in the flow diagram? 1268 

- Move the mention of Box 1 to the blue box on the right? 1269 

 1270 

Fig. 3. ⏐ Typical burns for LA-REIMS analysis. LA-REIMS burns as acquired for a stool sample 1271 

in negative (a) and positive (b) ionization mode, with an MS scan time of 0.3 s per scan and 1272 

(automated) laser ablation time of 3 s.x 1273 
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From this it seems that the instrument is continuously scanning. I am intrigued about the 1274 

baseline. I assume that this should be a constant that is made up of the solution that may or 1275 

may not contain external standards. 1276 

 1277 

Fig. 4.⏐ Close-up of the motorized automated sampling area and its connection to the 1278 

REIMS source: (a) Configuration of the motorised stage, with the laser beam focused on the 1279 

surface of the stage and the sample tube positioned above the laser focus point. (b) Picture 1280 

of the connection of the sample tube through the stainless-steel T-shaped connector piece 1281 

with the solvent line and the inlet of the REIMS source. 1282 

 1283 

Fig. 5. ⏐ Typical mass spectra as obtained by LA-REIMS analysis of human biofluids. 1284 

Acquired spectra for saliva (a, positive ionization; b, negative ionization), plasma (c, positive; 1285 

d, negative), urine (e, positive, f, negative), stool (g, positive; h, negative), milk (I, positive; j, 1286 

negative), and sputum (k, positive; l, negative), as obtained by a Waters Xevo G2-XS qToF 1287 

instrument. Adaptation from Van Meulebroek et al. (2020)10 and Wijnant et al. (2020)11.  1288 

- This is good as a quick “difference between sample types”. 1289 

- I wonder whether it would be good to have an annotated version showing some 1290 

detail – perhaps truncating at the first or second notch on the y axes, and highlighting 1291 

main metabolites that you would expect to see in the various sample types. 1292 

 1293 

Fig. 6.⏐ Typical m/z profiles as obtained by LA-REIMS analysis of human biofluids. Number 1294 

of features that were measured per m/z-class upon LA-REIMS analysis of saliva, plasma, 1295 

urine, feces, milk, and sputum, in positive (a) and negative (b) ionization mode. For each 1296 
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matrix type, a single list of m/z-features was acquired, based on the processing of ten 1297 

rawfiles (single burns), as obtained from ten different samples (i.e. individuals).  1298 

- - I wonder if this is the best way of showing this information.  I think that the profile 1299 

for each sample type might be more informative. i.e. the items on the x axis are the 1300 

sample types, and the different coloured bars are different m/z classes. The problem 1301 

with this current figure is that it is difficult to see that sputum bas a different profile 1302 

to urine. (for example) 1303 

 1304 

Fig. 7. ⏐ Multivariate modelling of pathophysiological state based on LA-REIMS 1305 

fingerprints. PCA-X (a) and OPLS-DA (b) score plot upon LA-REIMS fingerprinting of 1306 

feces to discriminate adults according to glycaemic state, i.e. type 2 diabetes (dark grey) (n = 1307 

36) and euglycemia (light grey) (n = 36). PCA-X (c) and OPLS-DA (d) score plot upon LA-1308 

REIMS fingerprinting of saliva to discriminate adolescents according to weight status, i.e. 1309 

healthy weight (dark grey) (n = 35) and overweight/obesity (light grey) (n = 35). Adaptation 1310 

from Van Meulebroek et al. (2020)10 and Wijnant et al. (2020)11. 1311 

 1312 
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maintenance procedures to
ensure stable performance

Consult the troubleshooting
section when problems

occur during system setup,
sample or data analysis
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